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NVIVO: 12Pro 
NVIVO is designed to facilitate common qualitative techniques for organising, analysing and sharing data in 
a research project.  NVivo can help you manage, explore and discover patterns in your data but it cannot 
replace your analytical expertise. 

  Access NVIVO 

 Double-click the Nvivo 12 icon on the Desktop 

 

 Complete profile details, if prompted 

 Add your initials.   
These will be used to identifiy your edits as you progress 

 Click on OK 
 

Getting Started 

  Open a project 
A standalone project is a .nvp file saved on your computer or on a network drive. 

 Click the File tab 

 Click Open. 

 
Note:  Ensure  NVivo Projects from the File or Project type list is 
displayed 

 Locate and select UQLTraining-NextSteps project 

 Click Open  

Working with Data 

  Import Content 

 

 Select Data - Files 

 Click the Import tab 

 Click the Files button 
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 Navigate to the Other Data folder  

 Double click Sea Grant Fact Sheet.pdf 

 Click on OK  

 Click on Import in the Import Files dialogue box 

 Click on OK in the Picture Properties dialog box 
when it appears 

 

The PDF is added to the list of files 
 

 

 Select Data – Files in the navigator 

 Click the Import tab 

 Click the Files button 
 

 Navigate to the Other Data folder  

 Select Barrier Islands and Cape Lookout.jpg 

 Click on Open 

 Click on OK  

 Click on Import in the Import Files window 

 Click on OK in the Picture Properties dialog box 
when it appears 

 

The image is added to the list of files 
 

 
A video or audio source consists of a media file and a transcript.  The transcript can be manually added, 
automatically created or purchased via NVivo and Transcribe. 

 Select Data – Files - Interviews 

 Click the Import tab 

 Click the Files button 
 

 Navigate to the Media Data folder 

 Select the Helen.mp3 audio file 

 Click on open 
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 Click on Import in the Import Files dialogue box 

 
 Go to the Audio tab in the Audio Properties 

dialog box 
Ensure Embedded in project is selected.  This should be the 
default setting 

 Click on OK  

The audio file will be added to the list of Data - Files 
  

Transcribe audio for coding 

 Double click the Helen audio file to open in 
details view  

 Click on Click to edit  
This will open the audio log for transcription beneath the file  

 Use the playback tools on the Audio Tools - Edit 
tab 

 
 Click to enter timespan 

 Add 0-10  

 Click next cell to enter transcript 

 Add “Interviewer Question”  

Purchase a transcript using NVivo Transcription 

You can purchase a transcript from NVivo.  As at February 2019 the cost per hour is $40 AUD with discounts 
for 5 and 10 hours. Turnaround is advertised as half the length of the audio. So a 1 hour file would take 30 
minutes to be available. See https://www.qsrinternational.com/nvivo/nvivo-products/transcription for full 
details of how to create an account and purchase credits. 

Import Transcript for coding 

 Click the Import tab 

 Click the Files button 

 

https://www.qsrinternational.com/nvivo/nvivo-products/transcription
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 Select Helen Transcript in the Media Data 
folder 

 Click on Open 

 Click on Import in the Import Files dialog box 

 Click OK 

 

 
 

  Coding Sources 

 

 Go to Data - Files 

 Double click Helen transcript to open the file in 
details view 

 Select “she doesn't want to sacrifice the 
environment to gain affordable housing” on the 
first row of content 

 Right click on selected text 

 Select Code… 

  

 Hold Ctrl to select nodes 
• Community Culture 
• Realestate Development 
• Natural Environment 

 Click on OK 
 

Check the Node hierarchy, coding has been added to the 
appropriate nodes  

 Repeat for other transcript paragraphs  

 
Be careful with PDF’s.  If the file has been created as an image coding specific content will not be possible.  

 Goto Data - Files 
 Open the PDF 
 Highlight the first paragraph 

 

 Navigate to Nodes to display Hierarchy 

 Expand Natural Environment if necessary 
 Drag and drop paragraph over Water Quality node 
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 Go to Data - Files 
 Open the image “Barrier islands and Cape 

Lookout” 
 Click and drag across the lighthouse in the image 

 
 Navigate to Nodes to display Hierarchy 
 Drag and drop selection over Natural Environment 

node  

  View Image Coding 
 Go to Nodes 
 Double Click to node Natural Environment to open 

it 
 Click link to image Barrier Islands and Cape 

Lookout 
The image coding reference will be pixel co-ordinates: 
starts at 330x270y and ends at 620x480y  

 The coded section will appear with shading 

 
 

  Create a new node 

 Navigate to Nodes 

 Select Node on the Create tab 

 

 Enter a name - Social Media 

 Add a description – NCapture Data 

 Click on OK 
 

The new node will be displayed in your node 
hierarchy. 
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Codebook 
A codebook is a list of your thematic nodes and their descriptions that you can export from NVivo. You (or 
members in your team) can refer to the codebook to ensure consistency of coding.   

  Create a Codebook 
Ensure your nodes have a description before generating a codebook. 

 

 

 Click Properties on the Home tab 

 Select Node properties… 
 

 Enter a description 

 Click on OK 

 

 

 On the Share tab click Export Codebook  
The Export Codebook dialog box displays. 

 
 

 Confirm a location for your codebook 
By default, the Automatically select subfolders check box 
is selected, so any subfolders will be included if you select or 
deselect a parent folder. 

 (Optional) Select Include number of sources and 
references check box. 

 Click OK. 
Note: Your codebook will display as an word document by 
default.  Save the file to keep a permanent copy. 

 

 

Alternatively: if you wish to share your codebook with 
other NVIVO users or Qualitive data programs you must 
save it is a .qdc file type 

 In the Export Codebook dialog box click 
Browse…  

 Change the Save as type: to Codebook 
Exchange Standard (*.qdc) and click Save 
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 Click OK 

  Import a Codebook 
 To provide easy reference to the codebook for all reaserchers, it can be imported back into your project. 

 On the Import tab click Codebook 

 Select the Codebook document (*.qdc) 

 Click on Open 
 

 Click on Import  

 
 

NCapture for web sources. 
NCapture is a tool which allows users to capture web content including web pages, social media and 
video/audio clips.  

  Import content with NCapture 
To use the NCapture tool you have to first of all add the extension to your browser.   

 

 Search in the browser 
“NCapture Google Chrome” 

 Click the link to the Google Web Store 

 

Check the extension available is offered by QSR International 

 Click “ADD TO CHROME” 
 

 Click Add extension 
A confirmation pop up may display.  You can now capture web content 
for your NVivo project. 

 
 

 Navigate to a web source: http://abc.net.au 

 Open any article 
 

http://abc.net.au/
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 Click the NCapture icon on the addressline 

 Select Source type: Article as PDF 
This may not be successful with sites that contain dynamic data 
which automatically updates. You may need to use WebPage as 
PDF but be aware this will include all content including ads. 

 OPTIONAL: Add a description 

 OPTIONAL: Code at Node – Social Media 
Add Node names for auto coding (New or existing) 

 Click on Capture 
The article will be converted to a .nvcx file and the NCapture 
progress page will be displayed  

 

 Navigate to youtube: http://youtube.com 

 Go to an appropriate media clip 

https://www.youtube.com/watch?v=DqDaZNyUKOg 

  

 Click the NCapture icon on the addressline 
 

 Select Source type: Video and Comments 

 OPTIONAL: Add a description 

 OPTIONAL: Code at Node – Social Media 
Add Node names for auto coding (New or existing) 

 Click on Capture 

 

 

Confirmation of the capture will be displayed 

 
 

 Navigate to a twitter feed: twitter.com/UQ_News 

 Click the NCapture icon on the addressline 
 

http://youtube.com/
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 Select Source type: Tweets are organised into a 
Dataset including Retweets 

 OPTIONAL: Add a description 

 OPTIONAL: Code at Node – Social Media 
Add Node names for auto coding (New or existing) 

 Click on Capture 

 

 
You may be asked to authorise NCapture to use your twitter 
account 

 Click on Authorize app  or Login 
You’ll be returned to the twitter page. 

 Click on Capture 
This can capture up to 5000 tweets 

 

The article will be converted to a .nvcx file 

 
 

 Open NVivo project 

 Navigate to Data - Files 

 Click Import Tab and click  NCapture 
 

 Browse to locate captures folders, if necessary 
Captures are usually located in the Downloads folder depending on the 
browser used. 

 Click Selected Captures 

 Select the captures to be imported 

 
 (Optional) Select Merging matching social media datasets  

This is the best way to bring in data captured over time 

 Click on the Import button  

 Navigate to Data - Files 
The imported content will be available.    
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  Explore Imported Social Media Content 
 

 Navigate to Data - Files 

 Double click UQ News Twitter  

 Click the Chart tab at the right  

 

 Click Select Data on the Chart tab in the ribbon 

 

 Select Timeline by quarter for the X-axis 

 Select Number of references for the Y-axis 

 

 Double-click the chart series to see tweets 

 
 

 Double click UQ News Twitter 
 

 Click the Cluster Analysis tab at the right 
A horizontal dendogram will display 
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 Change to a 2D or 3D cluster on the ribbon  

 Double-click on any entry to view details 
 

 

 Go to UQ News Twitter 
 

 Click the Map tab at the right 

 

 Double click a pin to see tweets 

 

 Right-click on map 

 Select Export Map…  

 Choose a save type, location and file name 

 Click Save 

 
 

  AutoCode NCapture import 

 Navigate to Data – Files and select UQ News Twitter 

 Click AutoCode on the HOME tab 
 

 Confirm Code at nodes or cases for each value in 
predefined Twitter columns 

 Click on Next 

 

 



 
 

 

 

 

 
 

 
 14 of 35 NVIVO 12 Pro: Next Steps 

 Select the Username and Hashtag options, if necessary 

 Click on Next 

 

 Enter a name for the Nodes – Twitter Hashtags 

 Enter a name for the Cases – Twitter Handles 

 Click on Finish 
This make take a little while depending on how many tweets you have  

 

  Explore Twitter Data 
 

 Navigate to Codes - Nodes 

 Expand Twitter Hashtags 

 Expand Hashtags 
This will let us see the hashtags used in the UQ_News twitter account 

 

 Click the References heading to sort column 

 Double-click any hashtag 

 
 

You will see all tweets with the selected hashtag 

 

 Click Dataset tab at the right 
This will display the dataset entry number with the tweet.  Tweets 
captured will only be 280 characters this may cut off any automatic links 
or URL’s 

 

Click a tweet link to navigate to source 
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 Navigate to Cases - Cases 

 Expand Twitter Handles 

 Expand Usernames 
This will let us see the most frequent users/references in the UQ_News 
twitter account  

 Click the References heading to sort column(if required) 

 Double-click any Twitter Username 

 
 

You will see all tweets with the hashtag selected 

 

 Click Dataset tab at the right 
This will display the dataset entry number with the tweet.  Tweets 
captured will only be 280 characters this may cut off any links or URL’s 

 

Click a tweet link to navigate to source 

 

  View Classification Sheets  
 

 Go to Cases 

 Select Case Classifications 

 Expand Twitter User 
A list of column headings or attributes for each user/case is displayed 
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 Select Home tab click on Case Classification 

 Select Twitter User 
The values of each attribute for each member is displayed.  This can 
be changed via drop downl lists attached to each cell 
 

 

 
  



 
 

 

 

 

 
 

 
 17 of 35 NVIVO 12 Pro: Next Steps 

Sets 
Sets are a flexible way of grouping your sources and nodes. Items in a set are references or 'shortcuts' to 
the original files. You can delete an item from a set without removing it from your project. 

  Create Sets for Analysis 

 

 Navigate to Search - Sets 

 Right-click on Sets folder 

 Select New Set 

 
 Add Long Term residents 

 Click on OK 

 Repeat for Incoming Residents  
 

 Right-click on set Long Term Residents 

 Select Add Set members… 

 
 Go to Cases 

 Expand interviewees 

 Select: Barbara, Dorothy, James, Margaret, Mary, 
Patricia,  Richard, Robert and Susan 

 Click OK  

All selected cases will be added to the appropriate set 

 
Repeat for In Coming Residents 

 Select: Charles, Daniel, Maria, Thomas, William 
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  Create a Matrix Coding Query using Sets 
Matrix coding query can easily compare coded material across different demographics or among themes.  
This can help you see patterns in your data and help you answer questions about your research.  We can 
look at the intersect between sets and nodes.  

 
What we want to know is… 
 What do long term residents and newcomers say about  Development Down East? 

 On the Explore tab click Query Wizard 
The Query Wizard dialog box opens 

 
 Select Find coding intersections between two lists of 

items 

 Click Next  

 Click Add Selected Items…  

 In the Select Project Items window select Sets 

 Long Term residents and In coming residents will be 
selected 

 Click OK 

 Click Next 
 

 Click Add Selected Items…. 
 

 Expand Nodes 

 Select Interview Questions 

 Click OK 
Theme nodes represent coded text in the content  

 Click Next 

  

 Search in Files & Externals 

 Click Next  
 Add this Query to Project if you wish to rerun the query 
again after or 
Run this Query once if you only wish to use the query 
once  
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 If you Add this Query to Project give the Query a Name 
and a Description (optional) 

 Click Run  

 You can run the query anytime from Queries in the 
Navigation view pane. 

 

 Double click set matrix result number to see content 

 
 

 Click Node Matrices on the View tab 

 Select Words Coded 

 

The number of words coded by each gender for each question will be 
displayed. 

 
 Double click on any number result to see the coded 

references 
 

 

Classifications 
Coding allows you to organize your sources for later data analysis.  Classifications are necessary to allow for 
further querying of data. They store information about your participants and sources.  They provide a way 
to record descriptive information about the sources, nodes and relationships in your project.  Think of this 
as a way of creating a database of imported content to help analyse it further.  You can only have one 
classification applied to a node or source at any time.   
These generally fall into 3 levels:  The Classification 
 The Attributes within the classification 
 The Values included in each attribute 
Assigning cases and sources to classifications will allow you probe your data in a bit more depth. 
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  Import a classification sheet  
NVivo associates your interview data with your attribute or demographic data through a case classification 

 

 Navigate to Cases – Case Classifications 

 Right click in List View 

 Select Import Classification Sheets... 
 

 Click on Browse… 

 Select Other Data folder - Interview 
Participants_Classification Sheet.xlsx  

 Click Open 

 Click on Next 
 

The key thing to this process is that NVivo will automatically recognize that you have a case node and associate all relevant 
information with the case provided that the name of the case node is exactly the same as the first cell in the spreadsheet  

Confirm Classifaction type is set to Case Classification 

 Select the options: 
a. Create new attributes 
b. Update the classification of existing sources or cases 
c. Replace attribute values of existing sources or cases 

 Click on Next  

Confirm how the cases are represented 

 Select As Names 

 Click on Select… 

 Select Cases\\interviewees 

 Select Create new cases if they do not exist 

 Click on Next  

 Confirm the Date, Time and Numbers formats 

 Click on Finish 
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The classification sheet will display 

 
 

 Navigate to Cases - Cases 

 Expand Interviewees (if necessary) 

 Select all interviewees cases 

 Right click on selection 

 Hover over Classification 

 Select classification: person  
The data will be classified with attributes but will have no assigned values yet. 

 

 

 

 Navigate to Cases – Case Classifications 

 Expand Person classification (if necessary) -  
Right-click Age Range 

 Select Attribute Properties… 

  
 Click the Values tab 

 Click the Add button 

 Enter 30-39 

 Click the Add button 

 Enter 50-59 

 Click the Sort button  

 Click the left side of the not available option 

 Click the Remove button 

 Click OK 
 

If the removed attribute value is in use you will be 
prompted to select an alternative – If so select 
Unassigned – click OK 
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 Assign a gender to each interviewee 

 Assign an age group to each interviewee 

 

Querying Data 

  Compound Query 
Compound queries combine node and/or text searches.  These can be used to check the thoroughness of 
project coding. 

 

 Select the Explore tab - Click Compound  

The Compound Query dialog box opens 
 

 Click the checkbox Add to Project 

 Enter a name Text coding  

 OPTIONAL enter a description 

 

 Click on the Compound Criteria tab 

 In Subquery 1 choose Text Search Query 

 Click on Criteria… 
 

 Enter text to search -  controlled 

 Click OK 

 
 Change the query option to AND NOT  

 This will exclude the subsequent criteria 

 In subquery 2 choose Coding Query  
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 Click on Criteria… 

 Select A particular Code or Case 

 Click select… 

 

 Select the Natural Habitat Node 

 Click on OK 

 Click on OK 
 

 Click the Query Options tab 

 Go to Spread Coding – Spread to - Broad Context 

 Click on Run (bottom left) 
 

 
Results will be displayed 
Tabs on the right allow results to be displayed as a Summary, by Reference, 
Text or Dataset 

  
 

  Create a Coding Query 
What we want to display is…All the interviews which over 50 year olds reference the Economy 

 On the Explore tab - Click Coding 

 
 Confirm Settings in the drop down boxes: 

ANY of the following are true 
Coded at Any Selected Code or Case 

 Click the Ellipsis button  



 
 

 

 

 

 
 

 
 24 of 35 NVIVO 12 Pro: Next Steps 

 Select Economy and its child nodes 

 Click on OK 

 
 Click the + symbol on the right to add another 

search criteria 

 Select Any Case Where 

 Click the ellipsis button   

 Expand Survey respondent 

 Select Age 

  

 Set the Age >=value  

 Set value to 50 
 

 Click Run Query 
Results may be displayed  

 Click Save Results… to keep a copy of results in the 
project 

 Click Add to project… to save the query settings 

 

 

If no results appear it might mean no coding exists at this point in 
time.  A message displays indicating there are no results.   
Change query settings or add coding before running query again.  
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Visualisation Tools 

  Code Charting 

 

 Select Codes – Nodes 

 Click on any node  
e.g. Codes – Nodes – Interview Questions – 
Q.1. Connecto to Down East  

 On the Explore tab select Chart  

 Select Chart Node Coding 

 

A chart will display reflecting a descending amount of coding 
for node content 

 
 

What we want to chart is… coding references in the interview questions by age group  

 Select the 6 interview question nodes  

 

 On the Explore tab - click Chart  

 Select Chart Coding by Attribute Value 

Chart Options dialog box opens 

 

 Chart items – X-axis Attribute - Select 

 Expand Person 

 Select Age Range 
 



 
 

 

 

 

 
 

 
 26 of 35 NVIVO 12 Pro: Next Steps 

 Click on OK 

 X-axis attribute (below Chart items): All attribute 
values except “Unassigned”, “Not Applicable” 

 Y-axis: Number of coding references 
 

 Click on OK 
A chart will display showing the coding criteria requested.  Use the chart 
tab on the Ribbon to change chart settings e.g Tye, Labes, Gridlines 

 
 

A Hierarchy chart lets you visualise the coding associated with either nodes or sources or the values 
assigned to either cases or sources. 

 Navigate to Codes - Nodes 

 Go to Interview Questions folder 

 Select all question nodes 

 

 On the Explore tab - Click Hierarchy Chart  

Hierarchy Chart wizard opens 

 

 Select Amount of coding for: Codes 

 Click Next 

 
 Compare: Select Items 

Click Select 
Expand Nodes 
Select all Interview Questions 

 Click OK  
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 Codes at: All Files, Externals & Memos 

 Click Finish  

A hierarchy chart of coding is displayed 

 
 

Exporting NVivo Data 

  Export Node References 
Node References will export to a Word document as a default 

 Select the node to export in List View  
(Natural Environment) 

 On the Share tab Click Export  
 

 Select Reference View 

 (Optional) select the Browse button to change 
the name, location or format of the exported file 

 (Optional) Select the properties and related 
content that you want to include in the exported 
file.  

 (Optional) Select the Open on Export check box 

 Click OK 
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The exported references will open 
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  Export a Node Summary 
A Node summary will export to an Excel spreadsheet as a default 

 Select the node to export in List View  
(Natural Environment) 

If you export a parent node with node aggregation turned on, the 
exported node includes content coded at the parent and content 
coded at all of the child nodes. 

 On the Share tab - Click Export 
 

 Select Summary View 

 (Optional) select the Browse button to change 
the name, location or format of the exported file 

Note: All the Include options are greyed out 

 (Optional) Select the Open on Export check box 

 Click OK 

 

The exported summary will open 

 

  Export a Node Matrix 
A Node Matrix query will export results to an Excel spreadsheet as a default 

 Navigate to Search - Queries 

 Double click Class Matrix to run 

 Right click anywhere in the matrix  

 Select Export Node Matrix  

 Click on Save 
The matrix will be available as a spreadsheet. 
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Reports and Extracts 
Reports contain information about your project that you can view and print.  An extract allows you to 
export a collection of data for complementary analysis in other applications. 

  Create a predefined report 

 

 Navigate to Output - Reports 

 Select the Reports folder  

 Double click Code Summary Report 
  

 (Optional) Click a check box if you want to filter results 

a. Click Select to define filter criteria 

 Click on OK 

 
The report is created and displayed in Details View.  This includes a Report Map and thumbnails.  Reports are dynamic and 
generated when run.  To retain this information as a snapshot of progress you can export the results or create an extract. 

 
 

 Right click on the report 

 Select Export Report Results 

 

 Navigate to a location for the extract to be saved 

 Choose Save as Type  if you wish to use a file type other 
than Word 

 Click on Save 

 

 

Report Map Thumbnails 

Report 
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  Create a predefined extract 
 

 Navigate to Output - Extracts 

 Select the Extracts folder  

 Double click Coding Summary by Code Extract   

 (Optional) Click a check box if you want to filter results 

a. Click Select to define filter criteria 

 Click on OK 

 

 Navigate to a location for the extract to be saved 

 Change the file type to MS Excel (*.xlsx) 

  Click on Save  

 

 A success message will display on completion. 

 
 

You may need to tidy up the extract before further analysis in Excel.   All numbers brought across will be 
interpreted as text.  This needs to be converted into numbers for reliable calculation 

 Navigate to Coding Summary by Code Extract.xlsx 

 Double click to open the spreadsheet 

 



 
 

 

 

 

 
 

 
 32 of 35 NVIVO 12 Pro: Next Steps 

 Select column J (Coverage) 

 Click Text to Columns on the Data tab 

 

As only the cell content needs converted we do not need any other steps 

 Click on the Finish button 

 

Ensure the column is still selected 

 On the Home tab click the Percentage button  

 

Extension Exercises 
Further Classifications 
If you do not have a spreadsheet of demographic information you are able to create your own classification 
sheets and apply appropriate content to each case or source classification. 

  Add ‘case’ classifications 
 

 A case can only be in one classification at a time 

 Navigate to Cases - CaseClassifications 

 Right click in List view 

 Select New classification 
 

 Add a name: Residents 

 Click on OK 
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 Click on Residents classification 

 On the Home tab click Case Classification select 
New Attribute 

 
 Add an attribute name - Age group 

 Go to the Values tab 

 Click on the Add button 

 Enter Over 50 attribute value 

 Click on the Add button 

 Repeat for Under 50 

 Click on OK   

 Repeat above to add a new attribute - Gender 

 Add the values Male, Female, Non Binary 

 Click OK  

  Add ‘File’ classifications 

 
 A File can only be in one classification at a time 

 Navigate to Data – File Classifcations  

 Go to Create tab - File Classification 
 

 Select Add one or more predefined 
classifications to the project 

 Click the checkboxes for the classifications to 
add: 

• Audiovisual Material,  
• Book  
• Electronic Article  
• Interview 
• Webpage 

 Click on OK  
The new classification for File Classifications will appear. 
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 Click on Data - File Classification  

 Select Interview 
The interviewees will be listed under this classification 

 

 Click on the plus symbol 
This will open the classifications to see attributes 

 
 

 Double click on Interviewer 

 
 Click the Values tab 

 Click the Add button  

 Enter Henry 

 Repeat for Nancy, Linda and Elizabeth 

 Click the default checkbox alongside Henry 

 Click on Apply 

 Click on OK 
If you choose to add values to a date and time attribute the 
format will be - dd/mm/yy hrs:mins:secs.am 

 

 

 Navigate to Data - Files 

 Go to interviews  

 Select all interviews 

 Right click on selected interviews 

 Hover over Classification 

 Select classification: Interview   
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  View Classification Sheet 

 Go to Data – File Classifications in Navigation 
view 

 Double click on interview 
The entries will be displayed with unassigned values  

 

  Click on an unassigned field 

 Select an appropriate value 
If all other entries have the same value copy and paste can be 
used to speed up the process. 

 

 

 
 Copy the first entry’s value (ctrl+C) 

 Select all other unassigned entries 
Click top entry, shift and click on last entry 

 Paste value (ctrl+V) 
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